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New 2D Workspace
If you are using only 2D AutoCAD® commands, 
why not use the new 2D Drafting & Annotation 
workspace? This capability displays powerful 
2D tools on the Dashboard.

2D Dashboard Control Panels
New 2D control panels provide easy access 
to layers and include controls for annotation 
scaling, text, dimensions, multiple leaders, 
tables, 2D navigation commands, object 
properties, and block attributes. When 
you select a tool from the Dashboard, the 
corresponding tool palette also displays, 
where applicable. 
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Tool Palettes 
When you drag geometry to an inactive tool 
palette, it is automatically activated for easy 
placement—just give it an extra second to 
switch.

•	 A new Specify Image option on the 
shortcut menu makes it easy to assign an 
image to any tool.

•	 The location of tools on a tool palette is 
now saved in the tool catalog (and the 
profile), making it easier to share your 
tool palettes with others and maintain the 
same look and feel.

•	 Use TPNAVIGATE to set a tool palette 
current at the command line (for 
programming purposes).

Clean Screen
Use the Clean Screen button located in the 
lower-right corner of the screen to turn off 
everything except for the status and menu 
bars and the command window. This feature 
comes in handy when showing files to a 
client and you need to quickly clean up your 
interface.
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Controlling Toolbar and Tool Palette 
Placement
Anchor your palettes to the left or right 
side of the drawing area for quick access. 
Palettes roll open or closed as the cursor 
moves over them, keeping them out of 
the way. You can easily stack several on 
each side of the screen for maximum 
productivity. Simply right-click the name 
bar, and choose Anchor Left or Anchor  
Right from the shortcut menu.

 

Layout Tab Improvements
•	 Rename a layout by double-clicking the 

Layout tab. 
•	 Reorder layouts with a simple drag-and-

drop.
•	 Use the Ctrl and Shift keys to select 

multiple layouts for dragging and 
dropping.

•	 Hold down Ctrl while dragging to create a 
copy.

•	 Drag layout tabs onto the active sheet 
set to add a new sheet, or select Import 
Layouts as Sheet from the shortcut menu.
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�Annotation Scaling

If you’ve found getting the proper scale 
factors per viewport to be frustrating 
and confusing, then you’ll love the new 
annotative scaling! No longer do you 
need to create multiple sets of text and 
dimensions on multiple layers. Now you 
create one set of annotative objects (such 
as text, dimensions, balloons, blocks, 
attributes, and hatches), indicate the 
desired actual plotted size, and it magically 
displays at the correct size.

Controlling Annotation Scale
A new annotative property can be assigned 
to objects such as text, dimensions, blocks, 
and hatches. Just create the object at the 
actual size you want it to plot and indicate 
the intended scale factor(s). Any object with 
an annotative property can have one or 
more scales assigned to it (such as ¼”=1’ or 
1:50). This capability makes it easy to display 
the same object in different viewports with 
varying scale factors. For example, the same 
text object could appear in one viewport 
that is scaled 1/8” = 1’, and another viewport 
at 1”=1’.

You can change an existing object to 
annotative using the Properties command. 

 Redefining a style or definition to be 
annotative does not affect existing objects. 
Use the new ANNOUPDATE command to 
update selected objects to match their style 
or definition (model space only).
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How can you tell if an object is annotative 
just by looking at it? Drag your cursor 
over the object to see the new annotative 
indicator.

 

 Set the annotative scale factor in 
model space to reflect the most prevalent 
scale factor in the drawing. 

For those objects that need to display at 
multiple scale factors, use the Properties 
palette to add scale factors. You can also 
use the OBJECTSCALE command. 

 It’s faster to use the OBJECTSCALE 
command when dealing with different 
object types.

New Annotative Controls on the 
Status Bar
•	 Use the two new controls on the status 

bar to set the VP Scale and Annotation 
Scale (accessible only if the viewport  
is unlocked). 

•	 A new Lock/Unlock Viewport button 
appears when a viewport is selected.

•	 Only the annotative objects that have  
the same scale factor as the viewport 
appear in a viewport. Toggle the new 
Annotation Visibility button to display 
annotative objects for all scales (even if 
they are not supported by the viewport’s 
current annotation scale).

 Use SCALELISTEDIT to customize the 
list of scales.

 If an annotative object disappears 
(and you don’t want it to), click the 
Automatically Add Scales to Annotative 
Objects button before changing the 
Annotation Scale. 
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Backward Compatibility
A new option on the Open and Save tab of 
the Options command helps ensure that 
those who are not using AutoCAD® 2008 
can see your annotative objects. Each scale 
of the objects is saved as an independent 
object on its own layer. The layers are 
automatically frozen in the appropriate 
viewport.

 If you have a large quantity of 
annotative objects, you can speed things up 
by turning off the Maintain Visual Fidelity 
option. Be sure to turn it back on before 
you save the file to a previous version!

 Linetypes are automatically scaled 
by the viewport’s annotation scale. Disable 
this behavior with the MSLTSCALE setvar 
if needed. A
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New Multiple Leaders
The new MLEADER command permits more 
control over leaders than ever before. Not 
only can you control the order of leader 
creation (head first, tail first, or content 
first), but you can also add multiple leader 
lines where needed.
 

New Multiple Leader Style Manager
The new MLEADERSTYLE command 
controls format and display options, just like 
dimension styles. New options include the 
following:
•	 Type of leader line (straight, spline, or 

none)
•	 Type of arrowhead
•	 Leader connection info
•	 Text information
•	 Assign a block (great for creating 

balloons!)

 

Dimensioning Techniques

 Use the shortcut menu to add leader 
lines. Use grips for speedy editing.

Aligning Leader Lines
Leaders not lining up properly? The new 
Multiple Leader Align tool snaps leaders 
into place for you. You can even control the 
spacing between them!

Use the MLEADERCOLLECT command to 
combine multiple block-type leaders into a 
single multiple leader. 
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Smart Dimension Break Command
The new DIMBREAK command breaks 
dimension or extension lines where they 
intersect objects or other dimensions.  
The breaks automatically update if you 
move the intersecting objects—even if they 
no longer intersect! You can also use the 
Restore option to remove all breaks.

More Cool Dimension Features:
•	 Create inspection dimensions with 

the new Inspection Dimension tool 
(DIMINSPECT). 

•	 Add a jog to linear dimensions with the 
DIMJOGLINE command.

•	 Evenly space dimensions with the 
DIMSPACE command.

•	 Dimension an arc beyond its endpoints 
with the updated diameter and radial 
dimension commands.

•	 Place the dimension text outside the 
angle being measured with the updated 
Angular Dimension command.

•	 The new Tolerance alignment option in 
the Dimension Style dialog box allows you 
to align decimal separators or operational 
symbols.
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Text Step Savers
Use these handy tricks to buy yourself some 
time when working with text in AutoCAD 
2008.

MTEXT Column Wrap
Ever wish text would automatically wrap 
across multiple columns in wide areas of 
your drawing? Your wish has been granted 
with the new dynamic columns option in the 
MTEXT command. Use grips along with the 
text formatting ruler to get the exact results 
you are after. 

Step Savers 

More Control over Paragraphs
The updated MTEXT command permits 
more control over paragraph alignment, 
indentations, and spacing. 
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More Efficient Spell Checker
No need to select objects first. The updated 
spell checker searches the entire drawing 
by default. You can also specify the current 
space or specific objects if you prefer. When 
an error is found, AutoCAD now highlights 
and zooms to the word in the drawing.

The new Check Spelling Settings dialog box 
allows you to customize the spell checker. 
You can choose to include dimension text, 
attributes, and xrefs, and set a variety of 
exclusions, such as capitalized words or 
words with numbers.

Create Attributes with Multiple Lines of 
Text
The new Multiple Lines option allows you to 
create attributes that support multiple lines, 
underlining, overlining, fields, and so forth. 

Step Savers
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Table Step Savers
Improved capabilities in AutoCAD 2008  
take away the pain when you’re working 
with tables.

Bidirectional Excel Tables
Wouldn’t it be nice if you could bring a 
Microsoft® Excel® file into AutoCAD and 
truly link the file? If you could change the 
Excel file and have it update in AutoCAD, 
and vice versa? Good times are here at last, 
because now you can do exactly that! 

Just use the updated Paste Special 
command, choose AutoCAD Entities, 
and select Paste Link to insert the Excel 
spreadsheet into AutoCAD. This process 
creates a data link. Should any changes 
occur in the XLS file, a bubble notification 
lets you know that the data link has changed 
and provides an easy option to update the 
table. 

Create a Table from a Data Link
A new option in the TABLE command also 
allows you to create a table from an Excel 
file. Just select all or part of the sheet. You 
can also create a table from object data.

Retain Changes in Tables
Any changes you make to an AutoCAD table 
are retained, even if you update the table to 
reflect any changes in the Excel file!

 Use the DATALINK command to 
manage all of your various data links.

Wrap Long Tables Across Multiple Rows
To wrap tables across rows, simply select 
the table and adjust it with grips or use 
the new Table Break tool in the Properties 
palette.
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Create Incremental Data Fast
New auto-fill allows you to quickly 
increment data in cells by dragging, just as 
in Excel. You can also combine blocks and 
text in the same cell!

More Step Savers
It just doesn’t get any easier than this!

View New Grip Tips on Dynamic Blocks
As you hover the cursor over a dynamic 
block grip, the associated parameter 
description displays as a tooltip.

Easily Extract Object Data	
Use the new DATAEXTRACTION command 
to sort and extract object data, such as 
plines, to a table (including summations!). 
This feature is great for gas or water lines.

Recover Drawings Along with Xrefs
A new drawing utility allows you to run 
the recover process on a drawing and all 
the associated xrefs. Find this capability 
under Files>Drawing Utilities or use the 
RECOVERALL command.

Change Copy Multiple Default
To default to a single copy, set the system 
variable COPYMODE to 1.

Publish Sheet Sets in Reverse Order
A new option on the Sheet List shortcut 
menu allows you to publish in reverse order.

Publish One Sheet at a Time
The new PUBLISHCOLLATE system variable 
allows you to print one sheet at a time. 
This variable allows other plots to enter the 
printing queue.

Step Savers
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Dashboard
The 3d control panels on the Dashboard 
provide a one-stop shop for nearly 
all things 3D. It can be found under 
Tools>Palettes>Dashboard or by entering 
the DASHBOARD command. 
•	 3d Make: Easily access 3d solids and 

surfaces.
•	 3d Navigate: Set up 3d views and 

animations.
•	 Lights: Add lighting to your model.
•	 Visual Styles: Create and move from one 

visual style to another.
•	 Materials: Apply materials and textures to 

objects.
•	 Render: Access basic rendering functions.

3d Tools 

OPTIONS 3d Modeling Tab
This tab focuses entirely on 3d functionality. 
Here are some highlights:

3D Objects
Controls the display of 3D solids and 
surfaces.

Dynamic Input
Use this control to add a Z coordinate field 
when using dynamic input. Be sure to turn 
it on!
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3d Objects
These settings control the display of 3d 
solids and surfaces.

Visual Style While Creating 3d Objects 
One means of switching visual styles (the 
Dashboard is another).

Deletion Control While Creating 3d Objects 
This key setting controls whether the profile 
and path curves are deleted once your 3d 
object is created. You may also choose to be 
prompted each time.

U and V Isolines on Surfaces and Meshes 
Controls the number of isolines for surfaces 
and meshes.

3d Navigation
If you’ve used Autodesk® Inventor™ 
software, you’ve noticed the wheel zoom is 
the opposite of that in AutoCAD. Now you 
can match them!

This section of the tab also enables you to 
control walk, fly, and animation settings.

 

3D
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Dynamic Geometric Feedback
•	 The size, shape, and location dynamically 

display as you create 3d objects, making 
it easier to visualize your design. Enter 
dimensions manually using Dynamic 
Input, or drag the cursor to specify 
dimensions visually.

•	 No more fighting with the UCS command. 
Now you can easily draw on a new work 
plane by passing your cursor over the 
edge of an existing face until it highlights. 
This becomes a temporary UCS (DUCS, a 
new button on the status bar, needs to be 
on).

•	 Object tracking now works dynamically in 
3d (even in perspective mode!).

 Holding down the Ctrl key as you pass 
your cursor over a solid lets you select the 
various components of the solid for editing 
(very handy!). Select the blue grip to edit. 
Select an axis on the grip tool to lock in an 
X, Y, or Z direction for easy editing.
 

 Use the spacebar to cycle from Stretch 
to Move to Rotate!
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173d Solids and Surfaces

Creating Solid Primitives
Creating 3d solid primitives is easy and 
intuitive because they follow the same steps 
as the correlating 2D commands.

Box
This is similar to RECTANG, but you can 
dynamically add the height. You can also use 
a center point to define the cube.

Wedge
Draw the base rectangle and the height 
(the sloped face is placed opposite the first 
corner). Cube option draws a wedge with 
equal sides. You can also use a center point to 
define the wedge.

Cone 
Same options as CIRCLE command to define 
base followed by the height, which is easily 
picked dynamically. You can also specify an 
elliptical base. Define height by selecting 
between two points (2P), or an axis 
endpoint. The Top Radius option creates a 
cone that does not meet at a point (cone 
frustum).
 

Cylinder
Same options as Cone, but the base and the 
top radius are equal.

Sphere
Same options you’d find in the CIRCLE 
command (center point, 3P, 2P, TTR), but 
this command generates a sphere.

3D
 Solids and Surfaces
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Pyramid
Use the PYRAMID command to draw a 
solid pyramid (similar to the POLYGON 
command). You’ll input the number of 
sides (3 to 32), base radius, inscribed or 
circumscribed (or use the Edge option), top 
radius, and height. 
 

Torus
Use the same options as the CIRCLE 
command to define the distance from the 
center of the torus to the center of the tube. 
Use 3P and 2P to define the circumference. 
Then define the radius or diameter of the 
tube.

Helix
It’s easy to create helical shapes by 
specifying the height, base, top radii, 
number, and height of turns and direction 
(clockwise or counterclockwise).

Creating Swept Solids and Surfaces
Creating swept solid and surfaces is also 
easy and intuitive with the tools available in 
AutoCAD 2008.

Polysolid
Draw a polysolid the same way you draw a 
polyline, but include a height and width (like 
walls). You can also convert an existing line, 
pline, arc, or circle into a swept solid.
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Extrude
Extruding an open object creates a surface. 
Extruding a closed object creates a solid. 
To create a solid from a profile using lines 
or arcs, use the Join option of the PEDIT 
command first to convert them to a single 
PLINE (you could also convert the objects to 
a region before you extrude).
 

Use the following extrusion profile options:
•	� Path: Specify an object as the profile 

for the path. The path is moved to the 
centroid of the object and used as the 
profile.

•	� Direction: Select the length and 
direction with two points.

•	� Taper Angle: Positive angles taper in 
from the base, negative angles taper out 
(0 is perpendicular).

 You can also extrude an existing 
face. Just use the Ctrl key to select.

 Press Ctrl+Alt inside an open or 
closed boundary to press or pull! You don’t 
even have to enter a command to do this 
extra cool tip!

Sweep
Sweep an open or closed profile along an 
open or closed 2D or 3d path. A closed 
curve results in a solid. The profile is moved 
and aligned perpendicular to the path—you 
no longer need to align it yourself. The final 
result is in the shape of the profile, or swept 
object. 

You can also twist or scale objects as they 
are swept.

 Use a helix as a path to create a variety 
of helical shapes.
 

3D
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Loft
Draw a 3d solid or surface through a set of 
two or more cross sections. Lofting through 
a set of closed cross sections results in a 
solid.

There are many options for getting the 
perfect loft: guide angles, drafting angles, 
smooth fit, and so forth.

 

Revolve
The updated REVOLVE command can create 
surfaces or solids based on the profile and 
axis of rotation. 
 

1.	 Select the objects to revolve.
2.	� Specify the start and endpoint of the axis 

of revolution.
3.	 Specify the angle of revolution.

Creating Surfaces
These commands make it fast and easy to 
create surfaces: 

•	� Convert objects into surfaces with the 
CONVTOSURFACE command. 

•	� Create surfaces from 3d solids with 
curved faces by using the EXPLODE 
command.

•	� Use XEDGES to extract wireframe 
geometry from solids, surfaces, and 
regions.

•	� Use PLANESURF to create a planar 
surface by  
•   �Selecting one or more objects 

that form an enclosed area 
      •   �Specifying the opposite corners of a 

rectangle

3D
 S

ol
id

s 
an

d 
Su

rf
ac

es



21

Creating Solids
With these commands, creating solids has 
never been easier: 

•	� CONVTOSOLID converts the following 
objects into extruded 3d solids: 
•  Uniform-width polylines with thickness 
•  �Closed zero-width polylines with 

thickness
      •  Circles with thickness
•	� THICKEN converts surfaces to solids by 

thickening a surface.
•	� SLICE creates new solids by slicing 

existing ones. Define the cutting plane 
by specifying points or by selecting a 
surface or planar object.

 

Creating Composite Solids
Union, Subtract, Intersect, Fillet, and 
Chamfer create composite solids. Use the 
Show History option in the Properties 
palette to display wireframes of the original 
forms that make up the composite (or use 
the SHOWHIST command).

3D
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Editing Solids
Easily edit existing solids in the Properties 
palette or by grip editing the solid. Use the 
Ctrl key to select the face or edge, or to 
select objects within a composite solid. You 
can also use the grip tool to move along an 
axis or plane by hovering the cursor over the 
Move grip of a selected solid.

 If you are having trouble selecting the 
correct face or edge, use the spacebar to 
cycle through all the possibilities.

Checking for Interference
Use INTERFERE to identify solids that 
interfere with one another. You can even 
select blocks and xrefs when searching for 
interferences and individual nested solids 
within a block or xref. Temporary solids 
are created and highlighted where solids 
intersect.

Align
Align works dynamically with 3d objects so 
you see the selected geometry align as you 
specify the destination points.
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233d Viewing 

3d Orbiting and Viewing
Use the improved 3DORBIT command to 
view your 3d models. Dragging the cursor 
horizontally moves the camera parallel to 
the XY plane; dragging it vertically moves 
it parallel to the Z axis. The shortcut menu 
lets you choose from a variety of navigation 
modes.

Navigation modes are as follows:
•	� The Constrained Orbit mode keeps you 

from rolling the geometry completely 
over (3DORBIT).

•	� Free Orbit mode returns you to previous 
behavior and allows orbiting in any 
direction (3DORBIT).

•	� Continuous Orbit allows you to set the 
objects in continuous motion (3DORBIT).

•	� Adjust Distance controls the distance 
toward or away from the objects 
(3DDISTANCE).

•	� Swivel simulates the effect of swiveling 
the camera on a tripod (3DSWIVEL).

•	� Walk through a model at a fixed height 
above the XY plane (3DWALK).

•	� Fly through the model without any 
height restrictions (3DFLY).

•	� Similar to Adjust Distance, Zoom 
simulates moving the camera closer or 
further away (3DZOOM).

•	� Pan moves the view in the direction you 
drag (3DPAN).

 Press Shift+middle mouse button for 
quick access to 3DORBIT.

Perspective
Easily toggle from Perspective to 
Parallel from the dashboard, or use the 
PERSPECTIVE system variable.

Walk-Throughs
Use 3DWALK to walk-through your design 
using the four arrow keys. Alternatively, use 
W, forward; A, left; S, back; D, right. Drag 
the mouse in the direction you want to look. 
Perspective mode must be on.

 Use the mouse wheel to roll in a walk-
through and the left mouse button to swivel 
to a new direction. Adjust the step size and 
speed in the Navigation control panel.
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 You can also create an animation of 
your walk-through (ANIPATH command).
 

Creating Cameras
Use the CAMERA command to set up 
cameras for viewing your design. A camera 
icon is added to the drawing with a 
corresponding named view. 
•	� Location: The point from which you are 

viewing the model.
•	� Target: The point that you are viewing 

(center of the view).
•	� Lens Length: Magnification properties of 

the camera’s lens. The greater the lens 
length, the narrower the field of view.

•	� Front and Back Clipping Planes: Specifies 
the boundaries that define or clip a view. 
Everything between the camera and the 
front clipping plane is hidden. Everything 
between the back clipping plane and the 
target is hidden.

 Use the drop-down menu in the 
Navigation control panel of the Dashboard  
to quickly restore a camera’s view.

Visual Styles
Use Visual Styles to quickly change the 
display of edges and shading in a viewport. 
Create your own Visual Styles in the Visual 
Style Manager.
•	 �2D Wireframe: Displays objects using 

lines and curves to represent boundaries 
with model space colors.

•	� 3d Wireframe: Displays objects using lines 
and curves with a 3d look and feel. 2D 
objects such as raster images, OLE objects, 
linetypes, and lineweights are not visible.

•	� 3d Hidden: Wireframe representation, 
hidden lines removed.

•	� Realistic: Shades the objects and smoothes 
the edges. Materials are displayed.

•	� Conceptual: Shades the objects and 
smoothes the edges using the Gooch 
face style. Objects are outlined. Less 
realistic but easier to see.
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25Layers

The Layer command is the third most 
frequently used command in AutoCAD. 
These additions make this popular 
command even better!

Customize the Layer Manager
Now you control the display order of the 
layer property columns by dragging the 
column headings—put your favorites on 
the left for easy access. Too many columns? 
Turn off the ones you aren’t using by 
choosing Customize from the shortcut 
menu.

Freezing a Layer in All Viewports
The shortcut menu allows you to create a 
new layer that is frozen in all viewports, 
a function that is also available as a new 
button. Here you also find additional 
controls to freeze or thaw the selected 
layer(s) in all viewports. 
 

Renaming Layers
There are now three ways to rename a layer. 
Double-click the layer name, select a layer 
and press F2, or choose Rename from the 
shortcut menu.
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Layer Properties per Viewport
How often have you wished you could 
assign layer properties per viewport? Wish 
granted! No more tedium duplicating 
geometry on separate layers and flipping 
the layers on and off per viewport. Now 
you can double-click in a viewport and 
assign a specific color, linetype, lineweight, 
and plotstyle per layer that affect only the 
current viewport. (Hoorah!)  

 

Remove these viewport overrides 
from the right-click menu. Use 
VPLAYEROVERRIDESMODE (phew!) to 
temporarily ignore the overrides for viewing 
or plotting. These overrides affect only 
those objects that are bylayer. Use the new 
SETBYLAYER command to quickly change 
objects to bylayer, including those within 
blocks and nested blocks!

Direct Access to the Layer States Manager
A new LAYERSTATE command (LAS alias) 
provides access to the Layer State Manager 
from the command prompt (also on the 
layer panel of the Dashboard). Use the 
new Import option to bring in layer states 
directly from DWG™, DWT, or DWS files. 
Now you can also edit or view layer states 
from xrefs!
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New Layer Evaluation Tool
A new Settings button in the Layer 
command allows you to turn on a new layer 
evaluation tool. 
•	 The first time you save or plot, the current 

list of layers is stored for evaluation 
purposes.

•	 When new layers are added, an 
“Unreconciled New Layers” notification 
appears. Click the link to view the non-
matching layers.

•	 A new layer filter for unreconciled layers 
is automatically created.

•	 Layer Settings allows you to customize 
this process.

•	 Two new system variables, LAYEREVAL 
and LAYERNOTIFY, are now available.

New Layer Panel on the Dashboard
The new Layer panel provides quick access 
to all these cool new tools, including the 
very popular Layer Isolate (LAYISO) and 
Layer Unisolate (LAYUNISO) commands! 
New fading options allow you to lock and 
fade background layers, rather than hiding 
them completely.

Layers
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New CUI Features
Now you can customize the Dashboard and 
palettes with all your favorite commands in 
the CUI command. Simply drag a command 
from the command list directly to the 
palette. Customize the Dashboard by 
dragging commands to the new Dashboard 
panel that displays in the upper right of the 
CUI. You can even create a new row of tools 
on the Dashboard by dragging a toolbar 
from the Toolbar node to the Dashboard 
node.

A new search tool makes it easy to find 
commands. The macro associated with each 
command appears as a tooltip as you hover 
the cursor over the command. 

New Quick CUI
The QUICKCUI command displays a 
simplified Customize User Interface dialog 
box for speedy customization. Just drag 
commands to toolbars or palettes.
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New Dynamic Preview Panel
It’s easy to drag Dashboard and toolbar 
tools to the Preview Panel in the CUI.

Double-Clicking
When you double-click an object, a 
command is launched. Now you can assign 
which command is executed for each type 
of object! For example, when you double-
click an attribute definition, the DDEDIT 
command is executed, allowing you to edit 
only the attribute value. Maybe you’d prefer 
the EATTEDIT command, which allows you 
to edit all the properties in addition to the 
attribute value. Simply replace DDEDIT 
in the macro with EATTEDIT or drag Edit 
Attribute from the command list to the 
double-click menu.

 For you Autodesk Inventor users, why 
not assign 3DORBIT to the F4 key in the 
CUI? It will make the transition between the 
two products so much easier!
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Sharing your drawing information is 
important, and AutoCAD 2008 makes it even 
easier to do so.

Using DWF Files as Underlays
The DWFATTACH command enables you 
to use a DWF™ file as an underlay, just as 
you can with raster images. The DWF file is 
linked and not physically embedded into the 
drawing file, thus keeping the file size down. 
You can snap to an attached DWF file and 
adjust the fade, contrast, and monochrome 
from the Properties palette or DWFADJUST 
command. Use the shortcut menu to clip 
the DWF file and control the layer visibility 
of a selected DWF file.

 

Working with DGN files
Now you can attach Bentley MicroStation® 
V8 DGN files to your AutoCAD drawings or 
export DWG files to V8 DGN format using 
File>Export. Bring them in as externally 
referenced underlays with DGNATTACH 
using Insert>DGN Underlay. Clip the DGN 
from the shortcut menu (or use DGNCLIP) 
and use Properties to adjust contrast, fade, 
and monochrome (or DGNADJUST). 

Import V8 DGN data with DGNIMPORT 
using File>Import. When importing, a dialog 
box prompts for information regarding 
external DGN references, text nodes, and 
units to help you get the best results.
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Share

External References
Now you can use the XREF command to see all 
externally referenced files in one handy central 
location. Here you find any attached drawing 
files, DWF files, images, and DGN files.

A new option in the XCLIP command 
enables you to clip the inverse of a selected 
boundary by removing the inside rather than 
the outside.

 

Plotting to PDF
Use the Add Plotter wizard to print your  
drawings to PDF format. Under 
Manufacturers, select Autodesk ePlot 
(PDF), and under Models select PDF.

 

Access to DWG Files
AutoCAD 2008 lets you open DWG files 
all the way back to AutoCAD version 2.0 
(ancient!). 

•	� Backward and forward conversion  
of DWG files from AutoCAD Release 14 
to AutoCAD 2008 using the conversion 
features of DWG TrueView™ 2008 
software.

•	� Now anyone can view, publish, and plot 
DWG files with DWG TrueView. 

Download DWG TrueView for free (and we 
all love free!) at www.autodesk.com/dwg.

 Use DWG TrueView to quickly apply a 
page setup to multiple layouts!
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Lynn Allen, Cadalyst columnist and worldwide 
Autodesk Technical Evangelist, speaks to 
more than 30,000 users each year. For the 
past fourteen years she has written a monthly 
column in Cadalyst magazine called “Circles 
and Lines.” Lynn started using AutoCAD® 
software with Release 1.4, over 20 years  
ago, and has taught at the corporate and 
collegiate level for 13 years. A sought-after 
public speaker with a unique comedic style, 
Lynn is consistently one of the highest rated 
speakers at Autodesk University. Her latest 
book is entitled AutoCAD Professional Tips  
and Techniques. 

To purchase AutoCAD 2008 software, contact 
your Autodesk Authorized Reseller or visit  
www.autodesk.com/reseller to locate an  
authorized reseller near you.


